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ABSTRAKT
Metoda konečných prvků implementovaná v programu COMSOL Multiphysics je využí-
vána k analýze tzv. free-standing kmitočtově selektivních povrchů ve 3D. Tyto modely
jsou následně doplněny o periodické okrajové podmínky. Dále jsou free-standing povrchy
doplněny o vrstvy dielektrika a je zkoumán jejich vliv na modul činitele odrazu. V ana-
lytické části jsou vyhodnoceny vlivy počtu elementů diskretizační mřížky na přesnost
výsledku a délku výpočtů. Výsledky jsou srovnávány vzhledem k výsledkům uvedeným
v literatuře [5]. V závěrečné části práce je vysvětlen postup při generování m-file pro
obdélníkový element a použití globálního optimalizačního algoritmu PSO, který automa-
ticky upravuje rozměry vodivého motivu tak, aby bylo dosaženo průběhu modulu činitele
odrazu podle požadovaného průběhu.

KLÍČOVÁ SLOVA
Frekvenčně selektivní porvrchy, COMSOL Multiphysics, periodické okrajové podmínky,
Particle Swarm Optimization, Free-standing povrchy, COMSOL Script

ABSTRACT
Finite Element Method (FEM) implemented in COMSOL Multiphysics is used to analyze
free-standing frequency selective surfaces (FSS) in a 3-dimensional (3D) space. Practical
procedures for using periodic boundary conditions were developed and tested. A case
study concerning mesh grid density (number of elements) vs. results’ accuracy in a tight
relationship with the calculation time needed was worked out. Outcomes were compared
with results published in [5]. The procedure how to generate the m-file for a middle
placed rectangular patch is described in the last part of the thesis. Also, PSO is used to
adjust element’s dimensions to shape the module of reflection coefficient so it approaches
the shape of the objective function.

KEYWORDS
Frequency Selective Surfaces, Finite Element Method, COMSOL Multiphysics, Periodic
Boundary Conditions, Particle Swarm Optimization, Free-standing surface, COMSOL
Script
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1 INTRODUCTION

Frequency Selective Surface (FSS)s are periodic structures consisting of electrically
conducting elements (can be of various shapes, e.g. rectangular patches, dipoles, cros-
ses, etc.) placed on the dielectric substrate. Another available arrangement consits
of magnetic elements (slots on the conducting substrate). An incident electromag-
netic wave induces electric currents on the elements. If a secondary electromagnetic
wave radiated by the induced currents interferes in phase with the incident wave, the
selective surface acts as a reflector. If the interfering waves meet with an opposite
phase, reflected wave is zero and a selective surface behaves as a free space [1], [2].
FSSs can be used as frequency dependent reflectors (reflecting just at certain frequen-
cies), as band-pass radomes used to reduce the radar cross section of antennas outside
their operating band (waves at operating frequencies are propagating through) and
for other, mainly military, purposes [1], [2]. An ideal selective surface is infinitely

Fig. 1.1: Frequency Selective Surface.

large plane, what (not at first sight) simplifies numerical analysis of such a structure.
Nowadays, two approaches are used:

1. Method of Moments in Spectral Domain. A spatial spectra are calculated
from unknown current distributions on conducting elements (distributions are
the same at all elements). Since elements are placed periodically, the spectra
are discrete and unknowns then take a form of coefficients, which values are
acquired by solving a matrix problem. By substituting them, the current spa-
tial distribution is found [1].

2. Periodic Boundary Conditions. Just one element is numerically analysed.
If such an element is enclosed with edges, which mirror the element to infinity,
one infinitely large periodic structure is obtained. Used edges for such special
purpose are called Periodic Boundary Conditions (PBC), [1].

The first part of the project is dedicated to principals of the Finite Element
Method (FEM), particularly to a matrix problem leading to the method’s solution.
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Moreover, specific properties of a COMSOL In-Plane Waves Module used to all nu-
merical analysis are described. The theoretical part of this Diploma thesis deals with
a description and problematics of boundary conditions and their use in COMSOL
Multiphysics.

Non reflecting edges and periodic boundary conditions functionality is verified
in the practical part.

14



2 FINITE ELEMENT METHOD

FEM is a general numerical method used to solve partial differential equations. Since
Maxwell equations can be transcribed to this form, the finite element method can
be exploited to solve them. The finite element method consists of following steps.

2.1 Structure Discretization

Fig. 2.1: 2D finite element net template. blue numbers: local nodes. red numbers:
global nodes.

A discretization of the structure done by its division to a finite number of geo-
metrical shapes (see Fig. 2.1) has to be made preceding the own numerical analysis.
The best discretization method offering a compromise between the accuracy and
the calculation time is a Delaunahy’s triangulisation, permitting structure division
into mutually non overlapping triangles (triangles are adjacent). Delaunahy’s tra-
velling front triangulisation, Bowyer-Watson or Green-Gibson method are the most
used meshing approaches. Last two methods provide an adaptive discretization (a
smooth transition from a coarse to a finer mesh grid) [1]. The main motion of the
discretization (meshing) is a necessity of doing an electromagnetic’s field formal ap-
proximation over a satisfactory amount of discretization elements. A term formal
denotes, that the field is computed on the basis of unknown node values (triangle
vertices) using basis functions (may be linear, quadratic or cubic), where the basis
function over one triangle is defined as a function with unit value at one vertex and
zero value at remaining vertices. Formal approximation results form an input into
the original wave equation (this procedure is mathematically described in section
2.6), which for TM modes in a rectangular metallic waveguide look as [1]:

∂2e

∂x2
+

∂2e

∂y2
+

(
k2

0 − β2
)
e = R (x, y) (2.1)

A phase constant β denotes a phase change per length unit, k2
0 = ω2µ0ε0 is a wave

number of the propagating wave and the right side R (x, y) is a so called residual
function, which minimisation is done by weighting itself with basis functions.
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Fig. 2.2: 2 Dimensional finite element for a linear approximation.

2.2 Assembly of Matrices for Isolated Finite
Elements

Properties of all discretization elements have to be known before trying to proceed
the formal approximation of the electromagnetic field. Matrix transcripts for normed
mesh elements are used to provide easier and faster calculations, e.g. for a triangle
(see Fig. 2.2) and a linear approximation holds [1]:

Q1 =
1
2




0 0 0
0 +1 −1
0 −1 +1


 Q2 =

1
2




+1 0 −1
0 0 0
−1 0 +1


 Q3 =

1
2




+1 −1 0
−1 +1 0
0 0 0


(2.2)

Matrices above are used to calculate matrices of coefficients for every e isolated finite
element [1]

S(e) =
3∑

1

Qn cot g υ(e)
n (2.3)

and

T(e) =
A(e)

12




2 1 1
1 2 1
1 1 2


 , (2.4)

where A(e) is an area of the triangle.

2.3 Assembly of a Joining Matrix

According to an arbitrary chosen system, which has to be followed throughout the
whole numbering procedure, local nodes are numbered (see Fig. 2.1) countercloc-
kwise starting before the 90◦ angle. Global matrices of coefficients are assembled

16



from well known matrices of coefficients for each discretization element [1]

S =




S(1) 0 0 0
0 S(2) 0 0
0 0 S(3) 0
0 0 0 . . .


 T =




T(1) 0 0 0
0 T(2) 0 0
0 0 T(3) 0
0 0 0 . . .


 , (2.5)

where zeros denotes zero matrices with dimensions 3x3 (matrix dimensions must be
maintained to allow a correct matrix multiplication).

2.4 Unite of Isolated Elements

An aim of this procedure is to describe relations between local and global nodes.
First, a so called unite (joining) matrix C has to be set up. An illustrative example
below shows a content of the joining matrix C.

Finally, joining of isolated elements using the equation below takes a place [1]:

SC = CT SC, TC = CT TC (2.6)

Tab. 2.1: Joining matrix. Rows relate to local nodes, columns then to global nodes.
Values ”1” sign the local node’s membership to a global node. It is clear
from a comparison shown in Fig. 2.1, where global nodes counterclockwise
numbering was used, that local nodes 1 and 15 are joined (pertain) to the
global node 1 [1].

1 2 3
1 1 0 0
2 0 1 0
3 0 0 0
4 0 1 0
5 0 0 1
6 0 0 0 = C
7 0 0 1

15 1 0 0

18 0 1 0

21 0 0 1

2.5 Boundary Conditions Definition

A boundary conditions definition varies from one application to another. Basics can
be most easily described on a longitudinally homogeneous rectangular waveguide.
TM modes are expressly determined by a distribution of an electric field longitudinal
component EZ . This component must be zero on all conducting surfaces of the
waveguide (fulfils Dirichlet’s condition). Practically, we deal with this condition by
slightly modifying the joining matrix C, so all rows and columns referring to global
nodes are left out.

17



2.6 Matrix Problem Solution

A solution of a matrix problem is expressed with the equation [1]

SE + k2TE = 0. (2.7)

The numerical analysis result of this equation is a vector of eigenvalues k2 and a
matrix of eigenvectors E. Quadrates of eigenvalues k2 depict critical frequencies of
individual modes and each matrix E contains electric field intensity values on each
node. Those intensity values are then substituted into the formal approximation
which represents the longitudinal intensity component over each discretization ele-
ment.

In the next chapter, an analysis of an electromagnetic structure using the finite
element method in COMSOL Multiphysics will be exposed.

18



3 FREQUENCY SELECTIVE SURFACE
ANALYSIS

3.1 In-Plane Waves Application Mode

Since each application mode is defined by a differential equation, an appropriate
application mode has to be chosen preceding drawing the geometry and its analysis.

The In-Plane Waves Module is intended for stuctures with no variation in z axis
and wave propagating only in (x, y) plane. This application model offers solutions
for following field type distributions:

• TE waves

• TM waves

• TEM waves (hybrid mode waves). TEM wave is defined by a TE and TM waves
superposition. Moreover, the incoming wave can be defined as an elliptic or a
circular wave. Nither of two definitions was used in this Diploma thesis (the
incident field is always defined as a plane wave).

It can be stated for an electromagnetic field propagating in modelled (x, y) plane,
that only one none zero component for TE wave is presented (the one in z axis)
and that the magnetic field is suppressed to propagate only in the modelled plane.
Harmonic electric and magnetic field vectors can be then defined using equations [3]

E (x, y, t) = Ez (x, y, t) = Ez (x, y) eze
jωt (3.1)

H (x, y, t) = Hx (x, y, t) ex+Hy (x, y, t) ey = (Hx (x, y) ex + Hy (x, y) ey) ejωt(3.2)

Vectors E and H defines the electric and the magnetic field, where indi-
vidual vector components are distinguished using a subscript. Variable
ω is as commonly used to mark an angular frequency.

A more detailed theoretical and mathematical analysis concerning TE, TM and
hybrid TEM waves propagation is also mentioned in [3]. Since the one is used for
the FSS problem analysis (in 2D), a deeper application model knowledge is advised.

3.2 Vector Elements and Scalar Variables

According to the COMSOL documentation, a limited input scalar variables amount
can be used under different application modes. Those are for a planar wave propa-
gation µ0, ε0, ν0, λ0, where first two quantities refer to permeability and permittivity
in vacuum. If we want to solve a field distribution in a settled state (harmonic pro-
blem), frequency ν0 or a vacuum wavelength λ0 has to be defined. This listing ends
here for our model, though the listing for a 3D application mode is widened.

19



3.3 Boundary Conditions

Physical properties (again mostly the permittivity and the permeability) need to be
attached to model layers, after these have been designed (using COMSOL designing
tools or imported from a supported CAD program). A properties edit tool can be
found under Subdomain Settings from the Physics menu. A total parameters amount
quite varies - from a possibility of using predefined materials up to a tensor character
definition.

The next in the row is boundary settings on boundaries and edges (through
Boundary Conditions from the Physics menu. Their choice is driven by needs laid
on a model functionality. Using them, we tell the program how we wish the field
to look like on the boundary or in the near neighbourhood. The In-Plane Waves
Module allows the user to choose (with restrictions) from thirteen different types of
boundary conditions. Their description follows, since the right way of using them is
a key to a modeling of FSS.

3.3.1 Perfect Magnetic Conductor

We begin with Perfect Magnetic Conductor (PMC), on which surface field fits the
condition [3]

n×H = 0, (3.3)

where n denotes the normal vector.

Choosing this condition makes the program to force a zero value to the tangential
of magnetic field on the boundary.

PMC can be as well applied on interior boundaries if the propagating wave is
TM.

3.3.2 Electric Field

Boundary condition (Electric Field) is defined by the equation [3]

n× E = n× E0, (3.4)

where the E0 vector value refers to (by an user) set electric intensity
value on a boundary.

This condition is with advantage used to set up arbitrary electric intensity values
on the boundary. In addition to that, an incident field type (circle, elliptic or plane)
can be chosen. We are completely allowed to exploit this phenomenon on interior
boundaries only under harmonic analysis for TE modes.

20



3.3.3 Perfect Electric Conductor

Perfect Electric Conductor (PEC) is used in cases, when the tangential of an electric
field intensity on the boundary or the near adjacent area wants to be forced to a
zero value [3].

n× E = 0. (3.5)

In analogy with PMC, also PEC can be exploited for interior boundaries.

3.3.4 Scattering Boundary Condition

Scattering boundary condition introduces many new useful options to a finite ele-
ment method solution problem. Choosing and setting a boundary to be of Scattering
boundary type causes an incident field to propagate through the boundary without
any insertion loss or reflections. Such a boundary keeps those properties for both the
incident and the reflected field (reflected from objects placed behind the Scattering
boundary, not from the boundary itself). Also, those special properties work on the
same basis for cylindrical and plane incident waves, which intensities at the certain
point can be determined as [3]

E = ESCe−jk(n·r) + E0e
−jk(k·r) for a plane wave (3.6)

E = ESC
e−jk(n·r)

√
r

+ E0e
−jk(k·r) for a cylindrical wave, (3.7)

which input variables are the normal vector n, a position vector r, a
scattered wave electric intensity value ESC and an electric intensity value
created by an incident wave propagating from a direction described by
a wave vector k.

Scattering boundary conditions can be in suitable occasions replaced with Pefectly
Matched Layers (PML). However, controlling the wave’s behaviour is not a trivial
task then. Even in the simplest cases the layer thickness has to be adjusted to the
wavelength of a propagating wave. Moreover, one needs to keep an eye on the PML
functionality and effectivity since rather big computing errors might occur in some
situations. Also, PML does not belong to the boundary conditions set. Practically,
PML is an adding domain, which absorbs fields without any reflections. We introduce
PML to our design in cases we know a wave number of the incident field (wave).

3.3.5 Continuity

Fields modeling not rarely requires field continuity on the both sides of the edge
(e. g. interface between the two dielectrics). To do so, a Continuity is presented. In
terms of physics, electric and magnetic field tangential components are forced to be
continuous on the both sides of the edge. Finally, a mathematical formulation [3]

n× (H1 −H2) = 0 n× (E1 − E2) = 0. (3.8)
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Subscripts 1 and 2 denotes the electric and the magnetic field on inter-
faces 1 and 2.

We encounter use of the continuity mostly for measuring edges inside the structure
or on a transition between two subdomains representing the same material. One like
this does not influence the field forming and propagating inside the design.

3.3.6 Port

Tha last boundary condition type with most useful options is called Port. We find
its use to feed waveguides or other structures. Notice, that feeding can be done also
using other boundary conditions (e.g. by setting up initial values for the Electric
Field or by choosing the edge to be of the Scattering Boundary with its initial field
value), but only Port allows s parameter measurements without manually specified
formulas. All variables appearing in these formulas has to be solved by modeling a
field distribution within the structure beforehand.

S-parameters Calculated from a Field Distribution

S-parameter calculations using a Port boundary condition can be solved based on
two different approaches. The first approach is to perform an eigenmode analysis
and find Fundamental Modes on the ports. Fundamental mode values for port 1
and 2 and modeling in 2D are represented by vectors E1, E2, E3 (or by matrices in
3D). Further, fields (vectors or matrices) have to be normalized with respect to the
integral of the power flow across each port cross section. Finally, EC consisting of
an excitation plus the reflected field from the edge (b.c. port) is calculated. The s11

is given by [3]

s11 =

∫
port 1

((EC − E1) · E∗
1)dA1

∫
port 1

(E1 · E∗
1) dA1

(3.9)

S-parameters in Terms of Power Flow

The second option is to calculate s-parameters from the power flow through the
port. This approach does not allow to determine the s-parameters phase compo-
nent. Since we do not use this option in 2D, further properties description will stay
left untouched. The formula just for the comparison with the eigenmode analysis
approach follows [3]

s11 =

√
Pr1

Pi1
, (3.10)

where Pi1 denotes a power incident on port 1 and Pr1 represents a power reflected
from port 1.
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4 FREQUENCY SELECTIVE SURFACE
ANALYSIS WITH PERIODIC BOUNDARY
CONDITIONS

The first step while proving boundary conditions functionality (PBC are not involved
yet) is to design and analyse a simple structure. Scattering boundary conditions will
be tested and disscussed in this chapter.

Each analysis is highly dependent on a used model choice (a bad model leads to
bad results). Also, each model is described by its own (from other varying) differen-
tial equation.

For a planar wave propagation, we need to choose (from the COMSOL main
menu) modeling in 2D, then click on TE Waves in the RF folder and select Harmo-
nic propagation. Element type shall remain on the initial value Lagrange-Quadratic
(Fig. 4.1). The next step is to escape out of an awkward situation, when a just

Fig. 4.1: 2D In-Plane Waves model settings.

one shape is known and properties of the infinitely large plane made of such shapes
want to be find out. It is clearly understandable that we will not try to draw the
whole plane, but an other elegant solution has to be employed. The solution is the
application of PBC.

4.1 1 Dimensional FSS Without PBC

First, a simple structure without using PBC will be analyzed since this approach
can lead to sufficient results in some cases. In our case, the structure will be a slot
type FSS element. We can imagine the whole arrangement (see Fig. 4.2) as infinitely
long metal stripes (rising up from the paper plane) of the 0.4 m height, 0.02 m width
and 0.4 m distance separating two neighbouring stripes. The feeding (source) edge
is placed 0.5 m on the left, destination edge then 0.5 m on the right.
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Many times mentioned In-Plane Waves Module set up according to Fig. 4.1 will
be employed during the analysis. Comments on used boundary conditions have to

a) b)

Fig. 4.2: 1 Dimensional slot type FSS, TE: a) boundary conditions; green – Port,
blue – PEC, azure – PMC, black – Scattering Boundary Condition (Plane
wave, Electric field, E0z = 0 Vm−1), b) field distribution at frequency
388MHz (first null).

be made. The left (green) edge plays the feeding (source) edge role. The feeding is
done using Port, but on appropriate places its unique number (in our case ”1”), the
feeding power (1 W) radiated out of the port and the desired electric intensity value
E0z = 0 Vm−1 have to be specified.

However, using ports is a two face issue. The advantage might be, that a re-
flection coefficient is automatically calculated (no need to define complicated ana-
lytical equations) once at least one feeding port is defined in the structure. Definite
disadvantage due to wave reflections is a slightly lower solution accuracy if the port
was placed [3].

Worth mentioning are by azure color highlighted edges (working as PMC). Since
we want our structure driven by a plane wave, Scattering boundary conditions can
not be chosen. Their use would cause a part of the wave energy leaking through the
top and the bottom edge. Therefore PMC to create an optimal feeding (looks like
the feeding was done from an infinitely long wall) are employed.

Remaining, blue edges, signalising (just in this case) PEC and black (destination)
edge working as Scattering boundary conditions do not bring any progress to mo-
deling problematics and are not worth commenting.

This comment lack does no longer hold for a parametric analysis setup – made
from menu Solve, Solve Parameters. We type freq into the Name of Parameter
field and linspace(300e6,460e6,50) into the List of Parameter Values field. The
Linspace function secures the solution calculation on fifty equidistantly placed
frequencies in the range from 300 MHz to 460 MHz. Finally, the text freq has
to be typed next to the field nu rfwe in the scalar variables table.

Expectations of a resonance appearing at the frequency 375 MHz are fully right
considering structure dimensions. This theoretical value can be compared with the
s11 reflection coefficient curve (see Fig. 4.3). Since the reflection coefficient is defined
on the whole structure, any from offered points shown in Postprocessing, Domain
Plot Parameters, Point, Point Selection listbox can be used.
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Fig. 4.3: Reflection coefficient curve for a 1 Dimensional slot type FSS.

4.2 1 Dimensional FSS with Applied Periodic
Boundary Conditions

As stated earlier, the effective modeling can be achieved only if the analysis is
executed on a just one single element. This can not be held out other way than
using PBC. Fundamental for this operation is a structure shown in Fig. 4.4 top.
The PBC setup is controlled from menu Physics, Periodic Conditions, Periodic

a)

b)

Fig. 4.4: 1 Dimensional slot type FSS with PBC, TE: a) boundary conditions; green
– Port, black – PEC, azure – PMC, blue – Scattering Boundary Condi-
tion (Plane wave, Electric field, E0z = 0 Vm−1), b) field distribution at
frequency 388MHz (first null).
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Boundary Conditions. The opened window contains four tabs in total. Two for the
edge definition (the source and destination) and two for definition of the source and
destination vectors. The aim is to setup PBC so the structure seems to be infinitely
long in the vertical direction. The top edge will be considered as the source edge.

In the Source tab a number corresponding to the top (azure) edge shall be chosen
and text Ez should by typed into the Expression field. Text pconstr1 in the field
Constraint name is generated automatically, but can be replaced with an arbitrary
text.

Not ment to be changed is the parameter name in the Expression field. This
parameter is strictly dependent on the used model and is always stated in the window
intended to the model selection (see Fig. 4.1) – we find it next to the Dependent
variables field.

After switching to the Destination tab, we choose a number corresponding to
azure edge and tick on the checkbox next to the number (alternatively Use selected
boundaries as destination can be ticked). Finally, we type text Ez into the Expres-
sion field.

Source and destination edges are now defined. Also, each abscissa is defined by
two points (vertices). Reading in the Source Vertices field has to be filled in so
Source vertices list contains left and right vertices numbers moved from the section
on the left. Vertices numbers have to be selected in a fixed order. Edge directions
(the source and the destination) can be chosen arbitrarily (from the left to the right
in our case), but always in the same direction throughout the one element.

Confirm the settings by clicking on OK button, after you have defined vertices
numbers in Destination Vertices tab (in order left – bottom, right – bottom).

The parametric analysis setup is the same as in the 1 Dimensional FSS ana-
lysis case without PBC. Its result is a reflection coefficient curve on the input
(see Fig. 4.5), which has no dissimilarities comparing to the curve obtained du-
ring the analysis without using PBC. Both draw curves were obtained with meshing

Fig. 4.5: Reflection coefficient curve for the 1 Dimensional slot type FSS with applied
PBC.
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set to Normal. Increasing the mesh density does not lead to any markable changes in
the result’s accuracy. So the meshing mode Normal is satisfying and it is completely
useless to employ meshing grids with super high density which in consequence lead
to a long result time.
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5 FREE-STANDING FSS ANYLYSIS IN 3D

So far, this thesis has been dealing with 2D objects (planes of various shapes) and
their periodicity in one dimension1. To be able to move on and analyze structures in
a 3D with periodicity in two dimensions (plane), the In-Plane Waves Module needs
to be leaved and a 3D Electromagnetic Waves module will be used instead.

First functionality tests will be worked out on a so called free-standing surface
made of a rectangular shape. These results will be compared to results published in
[5] afterwards.

5.1 Introduction

Since all models showed throughout the thesis are somewhat derived and pulled up
from demo and teaching models published at Comsol international websites or distri-
buted with the installation package, the model documentation format is maintained
according to those materials.

5.2 Model Description

The goal is to design and analyse a structure shown in Fig. 5.1 in a frequency range
from 1 GHz to 50 GHz with a 1 GHz frequency step. A middle placed conductive

Fig. 5.1: A rectangular free-standing FSS.

patch, according to [2] belonging to a solid interior group, is surrounded by an

1It is recommended that reader spots the difference between the two terms – the first is de-
scribing the space dimension of the designed structure and the latter is defining a number of
dimensions, in which the structure will be extended to infinity.
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imaginary air block helping us to set up a source of an incident radiation (the top
boundary) and define gaps between single FSS elements forming the whole plane.
The conductive element is considered to be a free-standing. The term free-standing
well known from a FSS theory refers to a perfectly electrically conducting plane,
which thickness is typicaly less than λ/1000 [2]. No dielectrics is presented either over
or under the conductive patch. General solid interior group elements are assumed to
have a first resonance when their largest length is approximately equal to λ/2. For
example, for the biggest length 12 · 10−3 m, the first resonance is expected around
12.5 GHz.

The incident plane wave, with E component directing in the x direction, propa-
gates from the top boundary towards the conductive element, where some part of
it is deflected and the rest continues its way until it reaches the bottom (ideally)
non-reflecting boundary. Finally, side walls help the wave sustain its plane wave
character and force it to stay within the block’s boundaries. The back and the front
wall are assumed to be PMC and the left and the right wall are assumed to be PEC.

The key factor of modeling is a distance between the feeding (source) edge and
the conductive element. The optimal distance for an investigated frequency band
1 GHz-50 GHz is λ/2 at the frequency 15 GHz. Comparing to this optimal fee-
ding edge position, moving the feeding edge closer to the patch causes incorrect
results, whether moving it in the opposite direction leads just to increased amount
of calculation time while the results are still correct. An appropriate analysis and a
discussion on the feeding topic is given in Chapter 6.2.

If we flip through a litarature dedicated to FSS, we come to a fact that cha-
racteristics of a single element are a function of the polarization and the angle of
incidence. We can easily solve polarization issues. Unfortunately, we can not as easily
deal with angle issues. Basicly, there are two options available in COMSOL – nei-
ther leading to curves containing both the polarization and the angle of incidence
dependecies at the same time.

The first option, 3D Scattered Waves Module originally intended to solve the
reflected field scE offers a good scE accuracy and a little worse total field E solution
accuracy. Also, the routine handling the angle of incidence can be easily implemented
(without changing the shape of the geometry). What makes the module practically
unusable is a fact, that Port availibilities do not work and one has to perform an
eigenmode analysis in order to compute reflection coefficient values.

As follows from the previous discussion, the second – 3D Electromagnetic Waves
module is the only handy module we end up to work with. The polarization is
controlled using an appropriate Port settings, scE is computed while tolerating the
error and reflection coefficient values are computed automatically. All with no control
over the angle of incidence (the only way left is to manualy change the structure’s
geometry for every angle of incidence).

5.3 Model Navigator

1. In the Model Navigator, select 3D from the Space dimension list.
2. In the RF Module folder, select Electromagnetic Waves and Harmonic propa-

gation.
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3. Choose Vector, Linear from the Element list.
4. Click OK.

5.4 Options and Settings

1. From the Physics menu, choose Scalar variables.
2. In the Application Scalar Variables box, change two Expressions as stated in

Tab. 5.1.
3. Click OK.

Tab. 5.1: The Application Scalar Variables Settings.

NAME VALUE DESCRIPTION
nu rfw freq Variable name used to parametric analysis
E0iz rfw 0 Incident electric field, z component

5.5 Geometry Modeling

As already mentioned in previous chapters, drawing the structure should be con-
sidered anything but a simple task. Although the object can look the same after
taking different procedures, it selfdom is the same. The whole act of manually ty-
ping in object dimensions does not cause the main damage. Most bugs, resulting in
wrong curves and increases in a calculation time are caused by a misconception of
using subdomains. Everytime two or more overlapping subdomains are encountered,
a composite object consisting of them should be created. Note this step does not
have to be proceeded immediately after domains have been drawn (since changes
to once created composite objects are possible only in a limited extent, therefore it
is wise keeping the original domains as long as possible to be able to change their
dimensions), but has to be proceeded before the meshing procedure.

The drawing interface offers the Embed feature. Embedding is in COMSOL ana-
lysis mostly used to create conductive patterns (substitutes a term etching in tech-
nology) on a printed ciruit board (e.g. patch antennas), but can be used to create
face objects as well. The face object is a plane – not a subdomain, appears as an
infinitely thin layer and is not meshed. Put a little bit more precisely, only its inner
volume is not meshed (since there is not one). Their proper use helps to decrease a
number of mesh points and rapidly speeds up calculations.

All dialog boxes for specifying the primitive objects are accesssed from the Draw
menu and Specify Object. The software generates the content of the Name column
in the tables below automatically, so you do not have to enter them. Just check that
you get the correct name for the objects that you create.

Begin by creating a work plane for the conductive stripe:

1. From the Draw menu, select Work Plane Settings.
2. In the Work Plane Settings dialog box, select the x− y plane at z equal to 0.

Click OK.
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Tab. 5.2: FSS and air box dimensions.
NAME WIDTH HEIGHT BASE (X,Y) DESCRIPTION
R1 12 · 10−3 1.5 · 10−3 Center (0, 0) Conductive element
R2 15 · 10−3 7.5 · 10−3 Center (0, 0) Air wall boundaries

3. Draw two rectangles with the properties according to Tab. 5.3.
4. Select the small rectangle, R1, and select Embed from the Draw menu.
5. From the Draw menu, select Work Plane Settings.
6. Select the (x, y) plane and set z equal to −0.01. Click OK. This will change

the location of the work plane in the z axis in the 3D geometry.
7. Select the big rectangle, R2, and select Extrude from the Draw menu.
8. In the Extrude dialog box, enter 0.02 in the Distance field, and select Geom1

from the Extrude geomtery list. Click OK.

5.6 Boundary Settings

1. From the Physics menu, open the Boundary Settings dialog box, select the
Interior boundaries check box, and enter the settings according to the Tab. 5.3
(leave all remaining fields at their default values).

2. Click OK.

Tab. 5.3: The rectangular patch boundary settings using PBC.

BOUNDARY 3
Boundary condition Scattering boundary
Wave type Plane wave
Incident field Wave given by incident field

BOUNDARY 1, 6, 7 2, 5 4
Boundary condition PEC PMC Port

The port boundary condition settings should be set according to Fig. 5.2

5.7 Mesh Generation

Since the structure of the model is simple (no dielectrics and complicated shapes
are presented), an interactive meshing procedure can be used.

1. Click the Geom1 tab.
2. From the Mesh menu, choose Interactive Meshing>Delete Mesh.
3. From the Mesh menu, choose Free Mesh Parameters.
4. From the Free Mesh Parameters dialog box, select Normal in the Predefined

mesh sizes list.
5. Click Remesh.
6. Click OK.
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Fig. 5.2: The E-polarization Port settings.

5.8 Computing the Solution

1. Open the Solver Parameters dialog box from the Solve menu.
2. Select Parametric from the Solver list.
3. Type freq into the Name of parameter edit field and linspace(1e9,50e9,50)

into the List of parameter values edit field.
4. Click OK.
5. Click on the Solve toolbar button.

5.9 Postprocessing and Visualization

1. Select Domain Plot Parameters from the Postprocessing menu.
2. Choose the Point tab, and select S-parameter dB (S11) from the Predefined

quantities list.
3. Choose any number from the Point selection list (S-parameters are defined on

the whole structure).
4. Click OK.

The result of previous operations is a module of the reflection coefficient shown in
Fig. 5.3. The curve is plotted against the ideal solution obtained with [5] and together
with curve obtained with PBC, which settings are described in Chapter 5.11. We
can see, that the both curves obtained with COMSOL Multiphysics are shifted
downwards in the frequency by approximately 2 GHz and its shape in a range from
24 GHz to 37 GHz is less than similar to the ideal curve. Anyway, both null positions
are identical and the shape of the curves obtained with and without PBC are very
close.
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Fig. 5.3: The module of the reflection coefficient for the E-polarization.

5.10 H-Polarization Model Modification

Just minor model settings adjustments have to be taken to calculate reflection co-
efficient curves also for the H-polarization. To do so, the procedure from Chapter
5.3 to 5.9 should be followed, except the Chapter 5.6, where these steps need to be
worked out:

1. Two pairs of the boundary settings have to be changed according to the
Tab .5.4 (the remaining boundary settings stay the same as for the E-polarization
settings).

2. In the Port boundary settings, Electric field component E0x has to be set to
zero and E0y = 0 Vm−1.

Tab. 5.4: Boundary modifications for the H-polarization.

BOUNDARY 2, 5 1, 7
Boundary condition PEC PMC

There are more nonsimilarities in the H-polarization case. A null at frequency 40 GHz
is now shifted upwards for curves obtained with COMSOL and also, a null at 20 GHz
is missing comparing to [5]. Since this fall is very sharp, one might argue whether the
the code used in [5] to reach this curve is working properly. Again, curves obtained
with and without using PBC are almost perfectly identical.

Despite we can calculate reflection coefficient curves for both the E and the H-
polarization, we are not able to obtain results for both of them at the same time
in COMSOL graphic userface – neither can we do after exporting our model into
the Matlab code and running the routine. Thus analysis has to be worked out in
sequences with appropriate changes in code.
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Fig. 5.4: The module of the reflection coefficient for the H-polarization.

5.10.1 Equivalent Feeding Modes

Although one H-polarization feeding port settings was already described, another
working settings exists (settings with E0y = 0 Vm−1 and Eigenmode given by E field
should be changed to E0x = 0 Vm−1 and Eigenmode given by H field). Both options
are equall and it is only on a designer’s best wish which one to use.

5.11 Adding Periodic Boundary Conditions

From all the settings made so far, adding periodic boundary conditions is the most
exhausting one. To make them run in 3D, there is a variable implementing an extra
equation to explicitly set the divergence of the D or B field to zero. This variable
Ψ must also be made periodic [3]. Moreover, vector elements for the electric and
magnetic field are used. PBC settings for the E and the H-polarization are identical
and applied from the back to the front wall and from the left to the right wall.

1. Choose Properties from the Physics menu and set the Divergence condition
On.

2. Go to Physics>Periodic Conditions>Periodic Boundary Conditions.
3. In the Source tab, choose boundary 1 (left wall) from the Boundary selection

list.
4. Type psi in the Expression field. Text in the Constraint name is always ge-

nerated automatically.
5. Select the Vector element constraint check box and type tEx tEy tEz to the

next free Expression field below.
6. In the Source tab, choose boundary 5 (back wall) from the Boundary selection

list and do the same procedure as for the left wall.
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7. In the Destination tab, choose pconstr3 from the Constraint name list. Cho-
ose boundary 7, select the Use selected boundaries as destination check box
and type psi in the Expression field.

8. Choose pconstr4x pconstr4y pconstr4z, then boundary 7, select the Use
selected boundaries as destination check box and type tEx tEy tEz in the
Expression field.

9. In the Destination tab, choose pconstr1 from the Constraint name list. Cho-
ose boundary 2, select the Use selected boundaries as destination check box
and type psi in the Expression field.

10. Choose pconstr2x pconstr2y pconstr2z, then boundary 2, select the Use
selected boundaries as destination check box and type tEx tEy tEz in the
Expression field.

11. Switch to the Source Vertices tab, select numbers 4, 2, 1 in the Vertex selection
list and move them to the Source vertices list.

12. Switch to the Destination Vertices tab, select numbers 12, 10, 9 in the Vertex
selection list and move them to the Destination vertices list.

13. Choose another constraint in the Constraint name list and set Source Vertices
and Destination Vertices for remaining constraints according to the Tab. 5.5.
Always remeber to select numbers of vertices in order as stated in the this
table.

14. Click OK.

Tab. 5.5: Source and destination vertices numbers used for PBC.
Constraint name Source Vertices Destination Vertices
pconstr1 4, 2, 1 12, 10, 9
pconstr2x pconstr2y pconstr2z 4, 2, 1 12, 10, 9
pconstr3 4, 12, 11 2, 10, 9
pconstr4x pconstr4y pconstr4z 4, 12, 11 2, 10, 9
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6 SETTINGS CASE STUDY

6.1 A Comparison of Results Obtained
with and without PBC

Results for the E-polarization (cases with and without PBC) and for the H-polarization
(no PBC) have been so far more or less successfully compared to curves obtained in
[5]. An attentive reader might have a question whether it is necessary to use PBC.

As usual in the technical practice, we are looking for some kind of trade off, while
assuming a sufficiently small frequency step and a correct placing of the feeding
boundary. It should be stated in the first place, that it is rather hard to decide
which curve of the no-PBC – PBC pair is more correct (see Fig. 5.3 again). They
are both close to the ideal solution, appearing with the perfect match from zero
up to frequency around 20 GHz and with markable differences in the range from
35 GHz to 50 GHz. Their nonsimilarity and a possible calculation error (if there is
some) in this upper range can have two origins:

• In the no-PBC case, the assumption of an infinitely large plane is not fullfilled.

• In the PBC case, the mesh density (especially on boundaries at which PBC
are applied) is not sufficient and errors are cumulated while the structure is
being spread to the infinity in extent.

While a computational power of commonly availabe desktop machines used for tech-
nical calculations is still limited, time issues going hand in hand with a mesh density
and a frequency step (all curves in the thesis were calculated with 1 GHz step) come
in mind. Thus contents of Tab. 6.1 and Tab. 6.2 for the feeding edge position λ/2
and normal mesh should be compared. Interactive mesh procedure is driven by the
minimum element quality parameter value ( 0.3410 depicts a normal mesh) and since
the structures for both cases have the same dimensions, the same number of vertex,
edge and boundary elements is used. The only and most unpleasant difference is a
solution time, which is doubled for the PBC case (also holds for a fine mesh). All
calculations and time measurements were made running Matlab code with Matlab
connected to COMSOL Multiphysics.

Tab. 6.1: The feeding edge position, mesh density and a calculation time for the
E-polarization without using PBC.

Feeding Solution Number Minimum N. of N. of N. of
Edge Mesh Time of Element DOF Vertex Edge Boundary

Position [s] Elements Quality Elements Elements Elements
λ/4 normal 193 5853 0.4066 7697 12 106 1168
λ/2 normal 150 5024 0.3410 6708 12 102 1128
λ/2 fine 452 9508 0.4061 12358 12 130 1684
λ/2 finer 4209 29324 0.3655 36789 12 184 3428
λ fine 69 2555 0.4332 3594 12 98 798
λ finer 197 197 0.3878 9753 12 130 1652
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Tab. 6.2: The feeding edge position, mesh density and a calculation time for the
E-polarization with PBC.

Feeding Solution Number Minimum N. of N. of N. of
Edge Mesh Time of Element DOF Vertex Edge Boundary

Position [s] Elements Quality Elements Elements Elements
λ/2 normal 295 5024 0.3410 7841 12 102 1128
λ/2 fine 1000 9508 0.4061 14383 12 130 1684

Since dimensions for the H-polarization modification have not changed, there
will be no surprise while looking through the Tab. 6.3 and Tab. 6.4. Again, time
needed while using PBC is doubled comparing the PBC and no-PBC case. Some
deviations in the solution time can be considered minor and will be caused mostly by
allocating the operating memory and a computional power of the CPU for programs
running on the background. Also, time needed to reach the E and H-polarization

Tab. 6.3: The feeding edge position, mesh density and a calculation time for the
H-polarization without using PBC.

Feeding Solution Number Minimum N. of N. of N. of
Edge Mesh Time of Element DOF Vertex Edge Boundary

Position [s] Elements Quality Elements Elements Elements
λ/2 normal 134 5024 0.3410 6708 12 102 1128
λ/2 fine 430 9508 0.4061 12358 12 130 1684

curves is comparable. One might want to disscuss the influence of the mesh density

Tab. 6.4: The feeding edge position, mesh density and a calculation time for the
H-polarization without using PBC.

Feeding Solution Number Minimum N. of N. of N. of
Edge Mesh Time of Element DOF Vertex Edge Boundary

Position [s] Elements Quality Elements Elements Elements
λ/2 normal 272 5024 0.3410 7841 12 102 1128
λ/2 fine 1120 9508 0.4061 14383 12 130 1684

to the accuraccy of results. As can be seen from Fig. 6.1 showing reflection coefficient
curves for two mesh densities with PBC used, shifting the mesh density one level up
from the normal to the fine is followed by a slight curve’s shape improvement and
loaded by a huge solution time gap in a PBC case disadvantage (check Tab. 6.2).

6.2 Feeding Boundary Position Analysis

The feeding boundary position placed in a λ/2 distance in front of the conductive
patch was stated and recommended without giving any explanation. Unfortunately,
there is no math helping us to find a correct placing of this boundary for various
frequancy ranges. Thus its position has to be found out empirically running through
calculations, while moving the boundary closer and further. Two utmost distances
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Fig. 6.1: The module of the reflection coefficient for the E-polarization with different
mesh densities and PBC used.

exist, though. The closest distance should not be less than the wavelength of the
lowest frequency in the analyzed frequency range and the most distant position
should be kept as small as possible to use as little mesh elements as we can. Feeding
edge movement beyond this distance does not harm the model’s functionality and
can be recommended in cases we do not care too much about the mesh elements
number.

Curves for differenent feeding boundary positons are plotted in Fig. 6.2. The
optimal distance found was λ/2, where λ is a wavelength at frequency 15 GHz.
Nevertheless, remember to move the feeding boundary as far as you can if you have
enough computational capacity.
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Fig. 6.2: The feeding boundary position for the E-polarization (works for the H-
polarization as well).
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7 OCCUPIED ELEMENTS

We have so far analyzed a simple patch element placed in the middle of the air box,
where the air box around the patch defined the gap between the elements. This
arrangement can be redrawn into a formation with four identical rectangles placed
in the corners (see Fig. 7.1) with no expected changes in reflection coefficient curves.

From the modeling point of view, there is a new situation we have to be aware of.
The patch or any other shape is not placed in the middle and its metallic surface can
touch or even cross boundaries of the air box. Calculations on a redrawn formation
with four rectangles in the corners to test whether the arrangement with metallic
objects intersecting the dimensions of the air box will lead to our model’s failure are
covered in this chapter.

Moreover, if our model works even for this arrangement, then it can be exploited
to solve arrangements with more closely packed elements. Munk [2] calls this move
of approaching of single elements closer as occupying. Note that occupying is used
to shape reflection coefficient curves (the resonance and the bandwidth).

Fig. 7.1: A view from above at rectangular patches placed in the corners and cros-
sing the borders of the air box. Four patch elements with dimensions
a = 12 · 10−3 and b = 1.5 · 10−3 (a well known rectangular patch element
from previous chapters) is placed in a manner that their inter element
spacing is the same as for the element placed in the middle of the air box.

Turning our atttention back to Fig. 7.1, an object to analyze consists of an air box
R1 (created in a new Geom2 at the work plane set to (x, y), z = 0) with dimensions
A = 15 · 10−3, B = 7.5 · 10−3. The air box is then extruded into a 3D with a λ/2
height. Four patches R1, R2, R3, R4 are drawn (again in a Geom2 at the work
plane set to (x, y), z = 0) by specifying its dimensions and positions of their centers.

Although on the position of the patches outside the air box wouldn’t matter,
they sort of don’t look good and their presence increase the number of mesh points.
To get rid of them, select the Geom2 tab, then choose Draw>Create Composite
Object from the main menu and type R1*R2 + R1*R3 + R1*R4 + R1*R5 into the
Set formula field. Operators ∗ and + sign intersection and union of geometric objects.
The last step to take is to choose objects remaining after the joining operation and
embed them into a 3D at the work plane level (x, y), z = 0). The final structure
should appear as the one in Fig. 7.2. Since the redrawn geometry was on purpose
created to reach the same reflection curves as the original middle placed rectangular
patch, calculations were run to prove the design working. The model settings were
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Fig. 7.2: The final occupied structure with conductive patches placed in corners.

the same as the one described within sections 5.3 – 5.9 (section Geometry Modeling
is substituted by the description from the paragraph above), plus all four added
conductive pathes touching the corners have to be set to PEC. Moreover, the H-
polarization settings modification and equivalent feeding modes work without any
changes needed. For the PBC case, only source and destination vertices has to
be changed according to Tab. 7.1. Always remember to check twice whether the
Divergence condition in Physics>Properties is set On, otherwise you’re never gonna
get the curve you expected. Back to obtained curves which can be seen in Fig. 7.3.

Tab. 7.1: Source and destination vertices numbers used for the redrawn structure
with PBC.

Constraint name Source Vertices Destination Vertices
pconstr1 8, 24, 22 2, 19, 17
pconstr2x pconstr2y pconstr2z 8, 24, 22 2, 19, 17
pconstr3 8, 3, 1 24, 19, 17
pconstr4x pconstr4y pconstr4z 8, 3, 1 24, 19, 17

As understandable at the first sight, curves for the middle placed rectangular patch
and for the redrawn structure (both without using PBC) are identical. As a little less
pleasant, especially at frequecies under 15 GHz, comes out a comparison between one
of these curves and the curve for an redrawn structure with PBC used. Reflection
coefficient doesn’t reach its maximum value, while the first resonant frequency is
now at its ideal position according to [5] though. Also, a huge contrast in values is
to be found from frequency 1 GHz to 7 GHz and continues up to 15 GHz. An origin
of dissimilarity of the curves is uknown, but based on mesh density tests, the mesh
density is not the factor to put the blame on.
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Fig. 7.3: The E-polarization reflection curves for the redrawn structure with (solu-
tion time 752 s) and without PBC (351 s) plotted against the middle placed
patch reflection curve.
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8 REAL PERIODIC STRUCTURES

It is not uncommon that periodic surfaces are first designed as free-standing and then
(due to mechanical reasons, since the surface simply has to be placed on something)
other layers (dielectrics) are added hoping the original design won’t change much
[2]. As will be shown within the content of this chapter, this idea is fundamentally
wrong. Every added layer has a profound influence on the reflection curve. Namely,
it forms the shape of the curve and what is of more importance, it causes resonant
frequency shifts in direction downwards.

There are basicly three cases arising from Maxwell’s equations [2]. First, if a
periodic surface had been covered from both sides by an infinite dielectric material
of an infinite extent (with assumed εr), the resonant frequency reduction would reach
its maximum with a factor

√
εr.

Second, if the thickness of the dielectrics was reduced to a small thickness d ∼
0.05λε at each side of the periodic structure, the resonant frequency will change
to somewhere between f0 and f0/

√
εr. Note, that even for thicknesses as small as

d ∼ 0.05λε, the resonant frequency is fairly close to f0/
√

εr.
Third, if we have a dielectric layer only to the one side of the periodic structure,

the largest frequency reduction would be f0/
√

εr.
The behaviour described in recent three paragraphs is the same for dipole and

slot periodic surfaces covered by dielectrics of a small thickness. However, if the
layer(s) become thicker, more than λε/4, the two types will act differently [2].

8.1 Model of a Real Periodic Structure

A model with thin dielectric layers to the one and to the both sides of the periodic
structure (Fig. 8.3) was created to confirm whether the COMSOL is able to offer
correct results for such structures. An object to study is a chronically known middle
placed rectangular patch with dimensions according to Tab. 5.3. What is new, are
two thin layers to the both sides of the periodic structure with εr = 4. Each extruded
layer has a thickness d = 0.5 mm. The feeding boundary is now placed λ/2 from
the upper boundary of the upper dielectric layer. The distance from the feeding
boundary to the conductive patch is λ/2 + d) and the height of the whole bounding
air box is 2 · (λ/2 + d).

The model is set up in an usual manner. The Application Scalar Variables
settings, Mesh, the Parametric analysis setup, the Postprocessing setup are the
notorious ones used for a middle placed patch element without PBC. Adjustments
have to be applied on boundary settings, where the back and the front wall remai-
ning set as PMC, the left and the right are still PEC, the conductive patch is also
PEC, the top boundary is Port, the bottom boundary is a non-reflecting Scattering
boundary.

But, since we added dielectric layers, two new subdomains appeared. To decrease
a number of mesh points and prevent overlapping of volumes, a composite object
(operation Union) from the main menu Draw>Create Composite Object with the
Keep interior boundaries check box selected should be created. This operation will
result in a three new boundary planes and four subdomains in total. A relative
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a) b)

Fig. 8.1: A model of a real structure: a) 3D view on a structure with two thin
dielectric layers with d = 0.5 mm and εr = 4, b) the same model from a
lateral view.

isotropic permittivity value εr = 4 should be assigned to subdomains representing
dielectric layers from the main menu Physics>Subdomain Settings. A Continuity
boundary condition has to be assigned to the new trio of boundary conditions to
force the continuity of the electric and magnetic field. Curves to prove the truth are
not plotted in the thesis, but it was overviewed and positively tested, that Continuity
boundary condition doesn’t cause reflections and thereby have a zero impact on the
shape of curves.

8.2 Dielectric Thickness

As you might spotted, a threshold thickness of a dielectric layer was defined as
d ∼ 0.05λε, so to the wavelength in dielectrics with relative permittivity εr. As we
know from the FSS theory [2], a solid interior element should have a first resonance
at the double of its biggest length, what sets us around 12.5 GHz. But to stay
consistent and allow a conclusive comparison with results obtained so far, the first
resonant frequency is chosen to f0 = 15 GHz. The wavelength in dielectrics is then
evaluated as λε = c/(f0

√
εr) = 3 · 108/(15 · 109

√
4). Finally, a threshold dielectric

thickness d ∼ 0.05λε = 0.05 · 0.01 = 0.0005 m = 0.5 mm.

8.3 Results Comparison With Theory

Reflection curves are plotted in Fig. 8.2 and corresponding numeric data are pre-
sented in Tab. 8.1.

A wise move is to begin a comparison with a small dielectric thickness placed
just over the periodic structure, such as d = 0.25 mm. A theoretical first resonant
frequency reduction is maximally to 9.5 GHz. Our curve doesn’t reach this value,
what it is perfectly OK, since the shift is a matter of the thickness and there is no
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formula to use to predict the exact value. Moreover, curve’s shape is similar to the
one of the free-standing structure, except the higher resonances are now at 34 GHz
and 43 GHz.

Getting the model more complicated, a layer with d = 0.25 mm is added under
the periodic structure. Due to a larger total distance which the wave has to propagate
through, the first resonance is now even at a lower frequency (11 GHz), which again
satisfies the condition in Tab. 8.1.

The last shot is at a layer placed over and under the structure, each with d =
1 mm and simulating the infinite thickness, since it satisfies condition d > 0.05λε.
The first resonant frequency should be appearing close to 7.5 GHz (the lowest
frequency from all curves). As seen from Fig. 8.2, curve’s top is very close to this
value. The only reason curve doesn’t hit with its maximum a theorical value is that
the dielectric is not of an sufficient thickness, but still, its d = 1 mm is big enough
to push the resonance almost at the lowest possible level.

About meshing, after inspecting Tab. 8.1, one might think that adding a thin
dielectrics can’t cause such an accrual of mesh elements, since the total structure’s
dimensions didn’t changed so rapidly. This idea is completely true. The increase of
a number of mesh elements exists because it is an automatic meshing procedure,
working to reach the Minimal element quality value, we use. For thin subdomains,
many small elements have to be used to reach the Minimal element quality value,
while less elements are needed for thick subdomains (check Tab. 8.1 and a mesh
element number for d = 1 mm and d = 0.25 mm and remember that for a thinner
subdomain, even a one level less dense mesh was used to keep the number of elements
at the acceptable number).

Fig. 8.2: E-polarization reflection curves for variable dielectric thicknesses d with
εr = 4 for feeding edge position λ/2 + d from the conductive patch.
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Tab. 8.1: A solution time table with expected new first resonant frequency values for
various thicknesses of dielectrics with isotropic relative permittivity εr = 4
placed on both sides of the structure (b) or just over the structure (o). The
feeding boundary position λ/2 + d. The original first resonant frequency
f0 = 15 GHz.

Number Solution New expected
d [mm] Mesh of DOF time first resonant

Elements [s] frequency
1 (b) fine 7881 10331 fine close to f0/

√
εr (7.5 GHz)

0.25 (b) normal 15311 19220 normal between f0 and f0/
√

εr (15 GHz− 7.5 GHz)
0.25 (o) normal 15311 19220 normal max. f0/

√
(εr + 1)/2 (9.5 GHz)

8.4 Circular Ring Element Analysis

Free-standing rectangular patch element analysis results were described in previous
chapters. This element is considered to be one of the simple ones. There is basicly
an unlimited number of available shapes sorted into four basic categories though,
from which complicated shapes are derived [2]. Also as mentioned in [2], shape’s
symmetry is advantegeous, since such an element acts the same for all scan angles
within a chosen polarization. Therefore, a symmetric free-standing circular ring ele-
ment belonging to the ”Loops Type” group [2] with dimensions published in [4] was
analyzed and compared to curves published in this source.

The circular ring element analysis settings is no different to the analysis of the
rectangular patch element described from Chapter 5.3 to Chapter 5.11, clearly except
the section Geometry Modeling. The dielectics settings is done using the principle
described in Chapter 8. Loop type elements are supposed to resonate, when their

a) b)

Fig. 8.3: A circular ring element model: a) a 3D view on the structure with two
thin dielectric layers, each with d = 0.064 cm and εr = 3.5, the square
lattice spacing [4], the outer ring diameter 0.74 cm, the inner ring diameter
0.72 cm, the air box side length 0.85 cm, b) the same model from above.
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average circumference is approximately one wavelength long [2], so considering the
middle radius 0.73 cm, the resonance should appear somewhere around 13 GHz.
Also, dielectic layers pull the frequency down. Unfortunately, result in [4] is plotted

Fig. 8.4: The E-polarization reflection curve for a circular ring element. Number of
mesh elements 13880, mesh normal, solution time 641 s.

for a transmission loss, thereby it can’t be placed on a backround of the comparing
figure. Nevertheless, it can be seen (see Fig. 8.5) that maximum loss is at 8.4 GHz
while our model (see Fig. 8.4) proves highest reflection at 8 GHz.

Fig. 8.5: The transmission loss for a circular ring element published in [4]. Two
thin dielectric layers, each with d = 0.064 cm and εr = 3.5, the square
lattice spacing [4], the outer ring diameter 0.74 cm, the inner ring diameter
0.72 cm,
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9 GLOBAL OPTIMIZATION ALGORITHM

Practical steps needed to execute the FSS analysis for various shapes were revealed
and discussed in previous chapters. A designer is often facing a problem of finding the
element’s shape so its reflection coefficient (after expanding the element in extent
to infinity) meets some previously chosen requirements, mostly described using a
reflection coefficient curve as a function of frequency. Therefore it would be highly
time saving to have a powerful numerical tool, which will be adjusting element’s
dimensions in a smart and automatic way to reach such a goal. A global optimization
algorithm known as a Particle Swarm Optimization (PSO) will be applied on a free-
standing rectangular patch without any dielectric layers and with the E-polarization
of the incident wave.

9.1 Generating m-files

The main reason why COMSOL Multiphysics is so used and favoured is that it
provides a connection to Matlab via a client-server communication. And a connection
to Matlab means a well documented and fast calculation tool.

First, run COMSOL with Matlab otherwise you won’t be able to treat data
calculated by COMSOL in Matlab. The second step to make our design ready for
an optimization is to draw and setup a model using the COMSOL user interface
according to procedures published from Chapter 5.3 to Chapter 5.9.

Here comes the time to pay the highest attention. It is of the most importance
to proceed just those described steps (open proper windows just once, click on the
selected parts of the design just once). The model settings doesn’t fall apart if you
proceed those steps in a different order or open the settings windows twice, but you
are going to pay the highest price – calculation time. Be aware everytime you change
something (or even click on the structure) in the model, new lines of a Matlab code
are generated and added to the end of the already exising code. Finally, you may
wind up with thousands of lines instead of finishing with a few lines for our simple
structure.

The conversion of a model from COMSOL Multiphysics to a Matlab code is done
from the main menu File>Save As and by selecting Model M-file (*.m) in the Files
of type listbox. The raw code is then ready to be opened in Matlab.

Adding a header, so the model can be called as a function, is a must for the pur-
poses of the optimization. Check this header in the Appendix A, where dimensions
for the conductive element are depicted as a, b and dimensions for the surrounding
air box are depicted with A,B. The code also allows to choose the feeding edge po-
sition and a one of the total amount of ten mesh densities. The height of the air box
is the doubled feeding edge position. The optimal feeding edge position is λ/2 at the
frequency 15 GHz. Two terms (the first for a boundary settings and the second for
the feeding with an incident wave) have to be modified to make the model calculate
the reflection coefficient for the H-polarization case.

An access to data deserves a special attention. The solution data are stored
within a data structure, which is accessed via a COMSOL Script function
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posteval(xfem,’abs(S11 rfw)’,’Edim’,0,’Solnum’,’all’) belonging to a
Postprocessing Functions group. This function is presented to evaluate expressi-
ons in subdomains, boundaries, edges or vertices [3]. The expression to evaluate is
’abs(S11 rfw)’ – the module of the reflection coefficient. The value 0 attached to
the ’Edim’ parameter defines, that only values from vertices want to be pulled out
(’Edim’ value 1 would pull out the data from edges, 2 then from boundaries and
finally 3 from subdomains). The value ’All’ attached to the ’Solnum’ parameter
causes that data are pulled out for all 12 vertices appearing in our structure.

Although converting the model to a Matlab code allows a simple postprocessing
of the data, a new model and m-file have to be created for different structures placed
within the air box (the boundary and feeding settings stay unchanged comparing to
the rectangular patch element). Using the COMSOL graphic interface is by far the
easiest option to draw and setup the model. Of course objects can be created using
COMSOL Script, but this approach is complicated and predisposed to make code
errors.

9.2 Particle Swarm Optimization

The PSO is a robust stochastic evolutionary computation technique based on the
movement and intelligence of individuals (also known as particles or agents). It has
been shown that PSO outperforms other methods (genetic algorithms) of optimi-
zation in certain instances [6].

The whole principle is usually described using a swarm of bees in a field. The
goal of the principle is to find in the field the location with the highest density of
flowers without any knowledge of the field a priori. The bees start looking in random
locations with random velocities, but never exceeding the maximum allowed velocity
in a given direction. During their movement, every bee can remember the location
where it found most flowers (personal best) and also somehow knows other locations
where the other bees found its personal bests. As the bees fly and explore the field
with kind of movement fully described in [6], they are overflying locations of greatest
concentration and are pulled back toward them. Also, bees are overflying previously
encountered locations of highest concentration hoping to find the absolute highest
concetration of flowers (global best).

Moreover, every bee in the swarm appears at some place in the field (position).
This position is generaly somewhere in a N-dimensional solution space chosen accor-
ding to the problem. All evolutionary computation techniques require some function
or method to evaluate the goodness of a position. The fitness function must take
the position in the solution space and return a single number representing the value
of that position (this would be the density of flowers in analogy with our demon-
strating case). The fitness function represents the link between the optimization and
the physical problem and could in general be antenna gain, weight or some kind of
weighted sums of those factors [6].

Three types of boundary conditions are imposed by authors of [6] to keep search
to what is physically possible. When being hit, Absorbing Walls zero the particle’s
velocity, but allows the particle to be pulled back to the allowed solution space.
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Reflecting Walls change the sign of the velocity of the particle when being hit.
Particle then continues exploring in the allowed solution space.

Invisible Walls define the solution space (locations where fitness will and will
not be evaluated).

The core element of the whole method is an adjustment of particle’s velocity,
which is changed according to relative locations of personal and local bests. The
particle’s velocity is regularly updated with a time-step ∆t. Most literature omits
this value, therefore assuming its value to be one. Source [6] refers that value ∆t can
be factored out of equations describing the relation between the values of c1, c2 and
ω. Thus value of ∆t is implied in the selection of the other parameters. Note that
value c1 is a factor determining how much the particle is influenced by the memory
of his best location (increasing c1 encourages exploration of the solution space) and
c2 is a factor determining how much the particle is influenced by the rest of the
swarm (increasing c2 encourages exploitation of the supposed global maximum). ω,
known as inertial weight, is chosen to be between 0.0 and 1.0 and determines to
what extent the particle remains along its original course unaffected by the pull of
global and local best.

9.2.1 Code for the PSO

The complete PSO Matlab code for a middle placed rectangular patch element can
be seen in Appendix B. The input of the main function is formed by two numbers.
I defines how many individuals will be used within one generation and G defines a
number of generations. Each generation differs from the previous one by a change
of dimensions controlled by the PSO. The objective function (an optimal case to
which we want our solution to be close as possible) is a reflective coefficient curve
obtained with [5] for dimensions a = 12 mm, b = 1.5 mm, A = 15 mm, b = 7.5 mm.

The mesh density set to level normal, minimal frequency, maximal frequency
and a number of equidistantly placed steps within such defined frequency range are
declared as constats, since they are selfdom changed (although they can be quickly
placed in the function’s definition if needed). Also, the objective function is loaded
in the same section.

Individuals’ dimensions in the first generation are taken from a random guess
(see lines 25-28 in Appendix B). The guess is highly dependent on the constants
used on those lines. The further you set the constans away from the expected so-
lution dimensions, the more generations you are going to need to reach your goal.
Lines 29-30 are present just to keep dimensions of the conductive patch smaller than
dimensions of the surrounding air box.

The selection of the best individual (evaluating fitness) is based on counting
squares of the differences measured from the reflection coefficient curve to the ob-
jective funcion (see line 44 in Appendix B). The fitness values are listed in the
Matlab promt along with dimensions for each individual. The individual with the
lowest error related to the objective function is chosen after completing the solutions
for all individuals in the actual generation (line 48 in Appendix B).

The last crucial step is to adjust model’s dimensions and agent velocities between
single generations (lines 58-60). Both are influenced by constants defined on lines 18-
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19 (set to values recommended by [6]). Modification of these scaling factors doesn’t
influence the optimization as much as the value of time-step dt does. Change the
value of dt to 0.01 or 0.1 four rough estimates.

9.3 Results

PSO was let to work for a different number of individuals within one generation
and for a varying number of generations (remember to use a function format long
to increase a number of displayed digits in the Matlab promt, because the implicit
number of displayed digits may not be sufficient to spot small differences between
dimensions). Dimensions and the fitness for some typical algorithm runs are listed
in Tab. 9.1. An amount of generations not lower than three and a number of

Tab. 9.1: PSO results for a varying number of generations G and individuals I within
one generation.

(G, I) a [m] b [m] A [m] B [m] Solution time [s] Fitness
(2,4) 0.01234 0.00155 0.01412 0.00764 1265 0.7527
(3,6) 0.01112 0.00143 0.01574 0.00738 2856 0.4016
(2,9) 0.01252 0.00165 0.01501 0.00793 2768 1.0044
(4,5) 0.01161 0.00169 0.01468 0.00740 3211 0.7749
(1,10) 0.00114 0.00140 0.01428 0.00745 1458 0.6809
(3,9) 0.00113 0.00170 0.01587 0.00791 4364 0.4307

Fig. 9.1: Resulting reflection coefficient curves after several PSO runs and various
numbers of generations (G) and individuals (I). Runs with a number of
generations equal to three offered the best results.

individuals in a single generation around nine should be used according to results
in Tab. 9.1. An often stated value of eight generations and eight individuals can be
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used, but will proportionally extend the calculation time. Using a high number of
individuals and just one generation is controversial. The random guess procedure
generates the set of slighty different dimensions and we can hit the best fitness
value at the first shot if we are lucky enough. On the other hand, the algorithm
will not have a chance to modify dimensions since there are no other generations
to be calculated. Therefore a number of generations higher than one is advised to
allow the modification of dimensions according to the velocity of the individuals,
the inertial weightning factor and others (see line one in Tab. 9.1 with a perfect
fitness result). Also note that a good optimization result is not guaranteed even
when using a high number of individuals and generations (see Tab. 9.1, line three).
This is caused by a dependence on the inital guess, which wasn’t too good this time.
Hence the algorithm should be run through a couple of times to find the best result.

The caltulation time can be predicted having the experience from analysis men-
tioned early in this thesis. A solution period for one individual should take around
150 s for a case with no-PBC used. Hence a total solution time for two generations
and eight individuals within one generation will result in a time period approxima-
tely 16 ·150 = 2400 s. This assumption unfortunately holds only in a limited manner
(when dimensions of the rectangular patch are not too close to dimensions of the air
box). If you or the PSO algorithm for some reason change the dimensions of the two
mentioned above too close, the automatic meshing procedure will do the meshing to
reach a given minimum elemement quality value. In other words, it will use many
small elements to mesh these small areas. Since large areas may still exist and the
growth of the elements is on purpose limited (a given minimum element quality
value must be achieved on the whole design), the polygons grow slowly and many
small elements (smaller than actually needed) are used. You encounter this kind of
behaviour always when meshing objects with mutually non proportional dimensions.
A shot how to escape out of this would be to use a manually set meshing procedure –
to set a minimal element size for each subdomain, set growing of elements and so on.
This can be easily done via COMSOL Graphic interface and not that easily through
COMSOL Script. Moreover, the code to control whether the number of elements
used to mesh the whole structure isn’t too high or too low would be needed.
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10 CONCLUSION

Basic research to prove modeling of FSS working was carried out on a 1 Dimensioanal
FSS using a 2D In-Plane Waves Module. Two cases, the first with and the second
without using periodic boundary conditions offered the same curves for the module
of the reflection coefficient. Solution time differences between those cases were minor
due to analyzing in 2D. The 2D In-Planes Module was not found sufficient to fully
analyze FSS.

The 3D Electromagnetic Waves Module was used instead to allow analysis of FSS
with periodicity in two dimensions. Primary calculations were focused on building
the running model environment for a middle placed rectangular free-standing FSS
– how to most effectively draw the structure, how to feed the structure, where put
the feeding boundary and how to setup periodic boundary conditions. All issues
were solved and showed some positives (availability to reduce the number of mesh
elements using smart drawing techniques) and negatives (unwanted appending of
the Matlab code) of the COMSOL Multiphysics graphic user interface.

A variable Ψ implementing an extra equation to explicitly set the divergence
of the D or B field to zero and the vector element constraint tEx tEy tEz are
necessary to run periodic boundary conditions. Unfortunately, solving those two
extra equations introduces a massive increase of a solution time. The time period
needed is doubled comparing to the no-PBC case with almost no difference in the
shape for a module of the reflection coefficient. Curves calculated for a middle placed
rectangular patch and the E and the H-polarization were very close to ones calculated
with applet published in [5].

Adding thin dielecric layers (its thickness is determined to the wavelength in
the medium) enabled a comparison of curves obtained with COMSOL Multiphysics
to curves published in [2] and [4]. Various dielectric thicknesses and arrangements
simulated three extreme cases. Layers did cause resonant frequency shifts as expected
and results matched.

Global optimization algorithm PSO was introduced in the last chapter. The
algorithm changes the dimensions of the rectangular patch and the surrounding air
box so the reflection coefficient curve fits the objective function (reflection coefficient
curve obtained with [5]). The match is not perfect though. There are in general two
reasons to explain that. First, COMSOL Multiphysics calculates with some error
comparing to results obtained with [5] (assuming the same dimensions). Second,
Munk [2] says that curves for a chosen element type can be shaped only in a limited
manner (e.g. by packing the elements) and therefore you can not expect to obtain
arbitrary reflection coefficient curves. The latter reason is of a minor influence in
this case.

Many other models and simulations in addition to ones published in this thesis
were created during my work. One example for all, perfectly matched layer used
under the bottom of the air box hoping to reduce reflections didn’t lead to any
increase of accuracy and slowed calculations (a subdomain was added).

Inability to compute S-parameters values using an analytical formula (port had
to be used to generete the incident wave) weakened the potential of the model. This
complication escalated in inability to analyze FSS for an arbitrary angle of incidence.
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SYMBOLS AND DEFINITIONS

FSS Frequency Selective Surface

PBC Periodic Boundary Conditions

FEM Finite Element Method

PMC Perfect Magnetic Conductor

PEC Perfect Electric Conductor

PML Pefectly Matched Layers

PSO Particle Swarm Optimization

CBC Continuity Boundary Condition

PDE Parcial Differential Equation
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A M-FILE OF THE MODEL
01 function out = univ(a,b,A,B,mden,fmin,fmax,step)
02 %a - length of the conductive patch [m]
03 %b - width of the conductive patch [m]
04 %A - length of the airbox [m]
05 %B - width of the airbox [m]
06 %mden - mesh density (10, ..., 6-Coarse, 5-Normal, 4-Finer, ..., 1)
07 %fmin - min. frequency [Hz]
08 %fmax - max. frequency [Hz]
09 %step - number of lineary distributed steps within the frequency range
10
11 f = 15e9; c = 3e8; lam = c/f; %lambda
12
13 %Choose the feeding edge position (related to the wavelength at 15GHz)
14 %lam = lam; % lambda
15 lam = lam/2; % lambda/2
16 %lam = lam/4; % lambda/4
17
18 %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
19 % COMSOL Multiphysics Model M-file
20 flclear xfem
21
22 % COMSOL version
23 clear vrsn
24 vrsn.name = ’COMSOL 3.3’; vrsn.ext = ’’; vrsn.major = 0; vrsn.build = 405;
25 vrsn.rcs = ’$Name: $’; vrsn.date = ’$Date: 2006/08/31 18:03:47 $’;
26 xfem.version = vrsn;
27
28 % Geometry 2
29 g1 = rect2(num2str(a),num2str(b),’base’,’center’,’pos’,{’0’,’0’},’rot’,’0’);
30 g2 = rect2(num2str(A),num2str(B),’base’,’center’,’pos’,{’0’,’0’},’rot’,’0’);
31 g3 = embed(g1,’Wrkpln’,[0 1 0;0 0 1;0 0 0]);
32 g4 = extrude(g2,’distance’,[2*lam],’scale’,[1;1],’displ’,[0;0],...
33 ’twist’,[0],’face’,’none’,’wrkpln’,[0 lam 0; 0 0 lam; -lam -lam -lam]);
34
35 % Geometry 1
36 flclear fem
37
38 % Analyzed geometry
39 clear f s
40 f.objs = {g3}; f.name = {’EMB1’}; f.tags = {’g3’};
41 s.objs = {g4}; s.name = {’EXT1’}; s.tags = {’g4’};
42 fem.draw = struct(’f’,f,’s’,s); fem.geom = geomcsg(fem);
43
44 % Initialize mesh for geometry 1
45 fem.mesh = meshinit(fem,’hauto’,mden);
46 xfem.fem{1} = fem;
47
48 % Geometry 2
49 flclear fem
50
51 % Geometry objects
52 clear s; s.objs = {g1,g2}; s.name = {’R1’,’R2’}; s.tags = {’g1’,’g2’};
53
54 fem.draw = struct(’s’,s); xfem.fem{2} = fem;
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55 fem = xfem.fem{1};
56
57 % Application mode 1
58 clear appl
59 appl.mode.class = ’ElectromagneticWaves’; appl.module = ’RF’;
60 appl.gporder = 2; appl.cporder = 1; appl.border = ’on’;
61 appl.assignsuffix = ’ rfw’;
62 clear bnd
63 bnd.inport = {0,0,0,1};
64 bnd.E0 = {{0;0;0},{0;0;0},{0;0;0},{1;0;0}}; %Last term for E-pol{0;1;0}
65 bnd.type = {’E0’,’H0’,’SC’,’port’};
66 bnd.scsource = {’E’,’E’,’I’,’E’};
67 bnd.ind = [1,2,3,4,2,1,1]; %E-pol [1,2,3,4,2,1,1], H-pol [2,1,3,4,1,1,2]
68 appl.bnd = bnd;
69 appl.var = {’nu’,’freq’, ’E0ix’,’0’};
70 fem.appl{1} = appl; fem.frame = {’ref’};
71 fem.border = 1;
72 clear units; units.basesystem = ’SI’; fem.units = units;
73 xfem.fem{1} = fem;
74
75 fem = xfem.fem{2};
76 fem.sdim = {’x’,’y’}; fem.border = 1; clear units; units.basesystem = ’SI’;
77 fem.units = units;
78 xfem.fem{2} = fem;
79
80 % Multiphysics
81 xfem = multiphysics(xfem);
82
83 % Extend mesh
84 xfem.xmesh = meshextend(xfem,’geoms’,[1]);
85
86 % Solve problem
87 xfem.sol = femstatic(xfem, ...
88 ’solcomp’,{’tExEyEz10’}, ...
89 ’outcomp’,{’tExEyEz10’}, ...
90 ’pname’,’freq’, ...
91 ’plist’,[linspace(fmin,fmax,step)], ...
92 ’oldcomp’,{},’linsolver’,’spooles’);
93
94 % Save current fem structure for restart purposes
95 fem0 = xfem;
96
97 %Pull data out of the solution structure
98 bod = posteval(xfem,’abs(S11 rfw)’,’Edim’,0,’Solnum’,’all’);
99 out = bod.d(:,1);
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B PSO CODE
01 function [out,tim] = main( G, I)
02 % G - number of generations (iteration cycles)
03 % I - number of individuals in each generation
04 % x(1)= a - length of the conductive patch [m]
05 % x(2)= b - width of the conductive patch [m]
06 % x(3)= A - length of the airbox [m]
07 % x(4)= B - width of the airbox [m]
08
09 mden = 5; % set mesh density normal
10 fmin = 1e9;
11 fmax = 50e9;
12 step = 50;
13
14 t1 = clock; % time start stamp
15 load E pol S.mat; % objective function
16
17 dt = 0.001; % time-step
18 c1 = 1.49; % scaling factor (1.49)
19 c2 = 1.49; % scaling factor (1.49)
20
21 x = zeros( I, 5); % agent position
22 p = zeros( I, 5); % personal best
23
24 for n=1:I % initial guess and dimensions restrictions
25 x(n,1) = 11e-3 + 2e-3*rand(); p(n,1) = x(n,1);
26 x(n,2) = 1.3e-3 + 1e-3*rand(); p(n,2) = x(n,2);
27 x(n,3) = 14e-3 + 2e-3* rand(); p(n,3) = x(n,3);
28 x(n,4) = 7.0e-3 + 1e-3* rand(); p(n,4) = x(n,4);
29 if x(n,3) <= x(n,1), x(n,3) = x(n,1) + 0.002; end
30 if x(n,4) <= x(n,2), x(n,4) = x(n,2) + 0.002; end
31 p(n,5) = 1e+6; %set max. error
32 end
33
34 v = rand( I, 4); % agent velocity
35 g = zeros( 1, 4); % global best
36 e = zeros( G+1, 1); e(1) = 1e+6;
37
38 for m=1:G % +++ MAIN ITERATION LOOP +++
39
40 w = 0.5*(G-m)/G + 0.4; % inertial weight
41 %%%%%%%%%%%%%%Solve Using Comsol Script%%%%%%%%%%%%
42 for n = 1:I
43 vekt = univ(x(n,1),x(n,2),x(n,3),x(n,4),mden,fmin,fmax,step);
44 res = sum((vekt-stpf).^2);
45 x( n, 5) = res
46 end
47
48 [e(m+1),ind] = min( x( :,5)); % the lowest error
49
50 if e(m+1)<e(m)
51 g = x( ind, 1:4); % the global best
52 end
53
54 for n=1:I
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55 if x(n,5)<p(n,5) % the personal best
56 p(n,:) = x(n,:);
57 end
58 v(n,:) = w*v(n,:) + c1*rand()*( p(n,1:4)-x(n,1:4));
59 v(n,:) = v(n,:) + c2*rand()*( g(1,1:4)-x(n,1:4));
60 x(n,1:4) = x(n,1:4) + dt*v(n,:);
61 if x(n,1) > 14e-3, x(n,1)=14e-3; end % absorbing walls
62 if x(n,2) > 14e-3, x(n,2)=14e-3; end
63 if x(n,3) > 15e-3, x(n,3)=15e-3; end
64 if x(n,4) > 15e-3, x(n,4)=15e-3; end
65 if x(n,3) <= x(n,1), x(n,3) = x(n,1) + 0.002; end
66 if x(n,4) <= x(n,2), x(n,4) = x(n,2) + 0.002; end
67 end
68
69 end
70 plot( e); % plot the error function
71 out = g;
72
73 t2 = clock; % time stop stamp
74 tim = etime(t2,t1);
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